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1 Welcome 

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that 

can be used to monitor and control assets in space or on the ground.   

 

The TReK Command application provides the capability to update, send, and track 

commands.  Includes support for various types of command destinations including POIC, 

Suitcase Simulator, PRCU, RAPTR, and UFO.  It also includes the command bridge 

capability.   

 

1.1 Getting Started 

Start with the Introduction which provides an application overview.  Next, try the Quick 

Start Guides for “How Tos” for common functions.  For help with details, reference the 

Details section.  See the FAQ and Troubleshooting section for helpful hints and solutions 

to the common “gotchas”. 

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK 

software, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:            trek.help@nasa.gov 

Telephone:      256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time) 

Fax:                 256-544-9353 

 

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-

mail message is automatically forwarded to the TReK developers and helps cut the 

response time.  The HOSC Help Desk (256-544-5066) can provide assistance as needed 

and is available 24x7. 

 

 

3 Introduction 

The TReK Command application provides the capability to update, send, and track 

commands.  It includes support for various types of command destinations including 

POIC, Suitcase Simulator, PRCU, RAPTR, and UFO.  It also includes the command 

bridge capability.   
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4 Overview of the User Interface 

4.1 Main Window 

The main window contains several areas as shown in Figure 1.  The Command Track and 

Message Area are dock windows that you can float or dock.  To float a dock window, use 

your left mouse button to click and hold the title area while dragging the window to 

another area of the screen.  To dock, use the title bar to drag the dock window over the 

main window and drop. 

 

 

Figure 1 Main Window 

Toolbar 

The toolbar at the top of the window provides quick access to configure the application 

and start and stop the command service.  

 

POIC Command Status and Configuration Toolbar 

The POIC Command Status and Configuration toolbar (located under the Configuration 

toolbar) provides quick access to POIC Command Status and Configuration information.  

This toolbar is only available when a POIC destination is active. 

 

Command 

The Command area will display a list of commands when the command service is active.  

It will also display convenience buttons to perform functions such as updating a 

command or sending a command. 

 

Command Track 

The Command Track area displays the history of commands sent.   
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Message Area 

The Message Area displays important status and error messages.  The message area can 

be cleared using the View menu. 

 

4.2 Toolbar 

The toolbar provides visual information about the state of the application and provides 

access to common application functions.   

 

Configuration Status 

When the Configuration status is black, this indicates the application has not been 

configured.  When the Configuration status is green, this indicates the application has 

been configured and the command service can be activated.   

 

Use the Configure button to access the Configure dialog to configure the application. 

 

Operational Status 

When the Operational status is black, this indicates the command service is inactive.  

When the Operational status is green, this indicates the command service is active and 

tasks such as sending a command can be executed.  The application must be properly 

configured before the Activate button will be available.  The command service must be 

active before the Deactivate button will be available. 

 

Use the Activate button to activate the command service.  This will initiate all internal 

activities needed to support commanding tasks.  When you activate the command service, 

you will see activation status messages in the main window message area.   If you need to 

reconfigure the command application, deactivate the command service, and then push the 

Configure button to reconfigure. 

 

4.2.1 POIC Command Status and Configuration Toolbar 

The POIC Command Status and Configuration toolbar is shown in Figure 2.  This 

Toolbar will only be available when the Command service is Active and the Destination 

Type is POIC. 

 

 

 

Figure 2 POIC Command Status and Configuration Toolbar 

 

4.3 Menus 

The Command application menus are:  File, View, Command, Options, and Help.  Each 

of these menus is described in more detail below. 
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File Menu 

The File menu provides the capability to manage configurations and exit the application.   

 

View Menu 

The View menu provides the capability to clear the main window message area and show 

and hide different areas in the main window.   

 

Command Menu 

The Command menu provides the capability to configure the application, activate and 

deactivate the command service.  It also provides access to functions such as updating a 

command, sending a command, viewing command communication messages, and 

viewing command track information.  The Command menu is context sensitive and will 

display additional items based on the Command Destination Type.  As shown in Figure 3, 

additional menu items are displayed when the Command Destination Type is a POIC 

destination. 

 

 

Figure 3 Command Menu 

 

Options Menu 

The Options menu provides access to the Messages dialog, the Command Preferences 

dialog, and the Advanced Settings dialog.  The Messages dialog displays application 

messages.  The Command Preferences dialog provides the capability to configure 

preferences such as the Command Confirmation Prompt.  The Advanced Settings dialog 

provides access to advanced settings. 
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Help Menu 

The Help menu provides access to on-line help and application version information. 

 

 

5 Quick Start Guides 

This section provides “How Tos” for common functions. 

 

5.1 How to Configure the Command Application 

The following steps describe the minimum necessary to configure the application.  For 

additional information and details about the Configure dialog please reference section 

6.1. 

 

1. Push the Configure button to display the Configure dialog. 

2. On the General tab enter the Destination Name and Destination Type.  If the 

Destination Type is POIC, enter the HOSC Login Name.  Fill in the Communication 

Settings. 

 

Note:  If you are connecting to the HOSC, enter the Office Mode IP Address returned 

by the HOSC VPN client in the Local IP Address field.  If you are using Ku IP 

Services enter the Ground Proxy IP Address for the Destination IP Address. 

 

3. On the Command tab, add one or more commands to the Command list. 

4. Optional:  On the History tab, select the Yes radio button if you would like the 

application to write command history information.  Fill in the Directory.  It will 

default to the command_history directory in the trek_workspace directory. 

5. Push the OK button to save the configuration information and exit the dialog. 

 

If the application is configured correctly, the Configuration status will be green. 

 

5.2 How to Send a Command 

The following steps describe the minimum necessary to send a command once the 

Command service is active.  

 

1. Select a command in the Main Window Command List. 

2. Push the Send button located under the Main Window Command List. 

 

Note:  If the Command Send is successful, you will see the results in the Main Window 

Command Track Area.  If an error occurs you will see an error message. 

 

5.3 How to Update a Command 

The following steps describe the minimum necessary to update a command once the 

Command service is active. 
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1. Select a command in the Main Window Command List. 

2. Push the Update button located under the Main Window Command List. 

3. In the Command Update dialog, modify the command as needed. 

4. Push the OK button to save the updates and exit the dialog. 

 

5.4 How to Start and Stop the Command Service 

This section describes how to start and stop the Command service.  

 

1. Before the Command service can be started, you must configure the application.  To 

learn more about this see section 5.1.  The Configure status must be green before you 

can start the Command service. 

2. To start the Command service, push the Activate button on the toolbar.  If this is 

successful the Operational status will turn green.  When the Operational status is 

green you can start commanding. 

3. To stop the Command service, push the Deactivate button. 

4. When activating or deactivating important status and/or error messages will be 

displayed in the Main Window message area. 

 

 

6 Details 

This section covers various application details. 

 

6.1 Configuration 

The Configure dialog provides the capability to configure the command service.   Each 

tab is described below.  The Command configuration can only be modified when the 

Command service is inactive. 

 

6.1.1 General Tab 

The General tab is shown in Figure 4.  Each field is described below. 
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Figure 4 Command Configuration Dialog (General Tab) 

 

 

Destination Name 

This field should contain a user defined name for the destination. 

 

Destination Type 

The Command application provides the capability to communicate with different types of 

command destinations.  The Destination Type identifies the type of Destination.  

Destination Types include POIC, PRCU, RAPTR, SCS, and UFO.  The POIC, PRCU, 

RAPTR, and SCS destination types require a specific communication type.  When you 

select the Destination Type, the Communication Type menu will automatically be 

configured to the correct setting for the Destination Type.  The UFO destination is an 

“Unidentified Destination” meaning the TReK software has no knowledge about the 
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destination.  Therefore, you must set the Communication Type to the correct setting 

based on the interface supported by the destination. 

 

HOSC Login Name 

This field is only required for a POIC Destination.  It should contain the name of an 

active HOSC Login Session that was created using the TReK HOSC Login application.  

The Browse button can be used to view and select a HOSC Login Name. 

 

Communication Settings Area 

The Communication Settings area changes depending on the Communication Type 

setting.  For a POIC Destination, the Communication Type is automatically set to TCP 

Listener as shown in Figure 5.  For the PRCU, RAPTR, SCS destination types, the 

Communication Type is set to TCP Client as shown in Figure 6.  When working with a 

UFO destination, the following communication types are available:  UDP, TCP 

Listener, and TCP Client.  The UDP communication type is shown in Figure 7.    
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Figure 5 TCP Listener Communication Type 
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Figure 6 TCP Client Communication Type 
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Figure 7 UDP Communication Type 

 

Each of the fields used to define the communication settings are described below: 

 

Local IP Address 

A socket is created to send and receive command information.  This is the local IP 

address used for the socket. 

 

Local Port 

A socket is created to send and receive command information.  This is the local port used 

for the socket.  If the communication type is TCP Client or UDP, you can use 0 for the 

port and an available port will be selected for you. 
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Destination Information 

Destination information fields include the Destination Host Name, Destination IP 

Address, and Destination Port.     

 

Note:  If you are connecting to the Destination, enter the Destination Host Name or IP 

Address and the Destination Port.  If you are connecting to a TReK training tool that is 

simulating the Destination, enter the IP Address and Port corresponding to the 

configuration of the training tool.  For example, if you are running the training tool on the 

same computer as the TReK Command application, then you would use your local IP 

address for the Local IP Address and the Destination IP Address.  

 

Firewall Information 

If your computer is behind a firewall, and you need support for Network Address 

Translation, you can enter the information on the Firewall tab.  The Firewall tab is shown 

in Figure 8.   

 



TREK-USER-0014 

 13 

 

Figure 8 Command Communication General Tab Firewall Information 

 

Each field is described below. 

 

Firewall In Use (Network Address Translation Needed) 

Check the “Firewall In Use” checkbox, if your location is using a Firewall with network 

address translation. 
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Firewall IP Address 

The Firewall IP Address. 

 

Firewall HPEG Port 

The Port on the Firewall that should be used for network traffic. 

 

6.1.2 Commands Tab 

The Commands tab is shown in Figure 9.  The Commands tab is used to identify a set of 

commands that can be sent to the destination. 

 

 

Figure 9 Command Configuration (Commands Tab) 

 

Each field and button is described below. 
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Command 

The Command list is used to identify the set of commands that can be sent to the 

destination.   

 

Browse Database 

The Browse Database button is used to browse and select commands from a TReK 

Command Database. 

 

Browse Disk 

The Browse Disk button is used to browse and select a command defined in a TReK 

metadata file (Packet file). 

 

Delete 

The Delete button is used to delete a command from the list. 

 

6.1.3 History Tab 

The History tab is shown in Figure 10.  The History tab is used to enable the Command 

History capability.  Enabling the Command History capability will record information 

about each command sent including the name of the command, the content of the 

command, and the time the command was sent.   
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Figure 10 Command Configuration (History Tab) 

 

Each field is described below. 

 

Command History 

The No and Yes radio buttons disable or enable the Command History capability. 

 

Directory 

The Directory is used to identify the directory where the command history information 

should be recorded.  This will default to the trek_workspace command_history directory. 
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6.1.4 Bridge Tab 

The Bridge tab is shown in Figure 11 Command Configuration (Bridge Tab).  The Bridge 

tab provides the capability to enable the Command Bridge capability.  The Command 

Bridge capability provides a way to define a socket to receive an incoming command and 

redirect it to the Destination you configured on the General tab.  This provides a way to 

configure this application as a “central hub” for commanding activities. 

 

 

Figure 11 Command Configuration (Bridge Tab) 

 

Each field is described below. 

 

Bridge 

The No and Yes radio buttons disable or enable the Bridge capability. 

 

Default Command Name 

The Default Command Name is used to identify the default name that will be used when 

the command is sent to the destination.  The default command name does not have to be 

added on the Commands tab. 
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Command Mapping 

The Command Mapping checkbox is used to enable command mapping.  Command 

mapping is optional.  A command mapping file is used to describe mapping of incoming 

data to different command names based on an identifier value in the data.  If a command 

mapping file is not in use, or the incoming command cannot be mapped, the default 

command name will be used.   

 

Command Mapping File 

The Command Mapping File field is used to identify the absolute path to a command 

mapping file.  A command mapping file is used to describe mapping of incoming data to 

different command names based on an identifier value in the data.  It is a text file with 

keywords and required fields as described below (all keywords except BYTE_ORDER 

are required): 

 

➢ ID_START start_bit 

• start_bit – The offset from the beginning of the incoming data packet to the 

field for the identifier. 

 

➢ ID_LENGTH length 

• length – The length of the identifier in bits.  Note:  All identifiers are unsigned 

integers.  Lengths can be up to 64 bits.  

 

➢ BYTE_ORDER order 

• order – The byte order of the identifier as a string.  Valid values are 

big_endian, little_endian, byte_swapped, and word_swapped.  Default if not 

supplied is big_endian. 

 

➢ COMMAND value name 

• value – The unsigned integer value corresponding to the command. 

• name – The name of the command to use when sending.  Note:  No length 

restrictions are placed on the command, but some destinations may have 

restrictions.  The command names do not have to be added on the Commands 

tab. 

 

Example File (# is used for comments): 

 
# Example Command Mapping File 

ID_START       176 

ID_LENGTH      16 

COMMAND        0         NoOp1 

COMMAND        1280      NoOp2 

COMMAND        39320     ArmExit 
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Communication Settings Area 

The Communication Settings area is used to define the type of socket to use for the 

bridge.  The following communication types are available:  UDP, TCP Listener, and 

TCP Client.  Each of the fields used to define the communication settings are described 

below: 

 

Local IP Address 

A socket is created to receive the incoming command.  This is the local IP address used 

for the socket. 

 

Local Port 

A socket is created to receive the incoming command.  This is the local port used for the 

socket. 

 

Destination Information 

Destination information fields, as shown in Figure 12  include the Destination Host 

Name, Destination IP Address, and Destination Port.    

 

 

Figure 12 Bridge Communication Destination Information 

 

Firewall Information 

The Firewall tab is shown in Figure 13.  Each field is described below. 
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Figure 13 Bridge Communication Firewall Information 

 

Firewall In Use (Network Address Translation Needed) 

Check the “Firewall In Use” checkbox, if your location is using a Firewall with network 

address translation. 

 

Firewall IP Address 

The Firewall IP Address. 

 

Firewall Command Port 

The Port on the Firewall that should be used for network traffic. 

 

6.2 Command Area 

The Command Area is shown in Figure 14.   
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Figure 14 Command Area Populated with Commands 

 

When the Command service is activated, any commands defined in the Command 

Configuration are added to the Command Area in the Main Window.  Applicable 

Command buttons are also displayed.  The Command buttons will be disabled until a 

command is selected.  The Command buttons are described below: 

 

Update 

The Update button is used to update the contents of a local command.   The Update 

Command dialog will be populated with information about the command selected using 

the metadata identified when the command service was configured (TReK metadata file 

or a local TReK command database) and the contents from the last command update 

performed.  The Update Command dialog is used to modify the contents of modifiable 

command fields. 

 

Update POIC 

The Update POIC button is only available when the destination type is POIC.  When you 

push the Update POIC button, TReK submits a request to the POIC to update the contents 

of the command in the POIC database with the contents of the command data stored 

locally (the last update you made to the command contents). 
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Initiate 

The Initiate option is only available for a command that is associated with a POIC 

destination.  When you push the Initiate button, a request is sent to the POIC to build the 

command using the command data stored in the POIC database and then uplink the 

command.  TReK only sends the command name to the POIC since the POIC will get all 

the information on how to build the command from the POIC database. 

 

Note:  The POIC calls this type of command request a remotely initiated command 

request.  

 

Send 

The Send button is used to send a command.  TReK uses the command data stored 

locally (the last update you made to the command contents) to build the command uplink 

pattern and then send the uplink pattern to the destination. 

 

Note:  In the case of a POIC destination, the POIC calls this type of command request a 

remotely generated command request.  

 

6.3 Update Command Dialog 

The Update Command Dialog is shown in Figure 15.  This dialog is used to modify the 

contents of the command.  The only items that can be changed are the values of 

modifiable fields. 

 

 

Figure 15 Update Command Dialog 
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6.4 Command Track Area 

The Command Track Area is shown in Figure 16.   

 

 

Figure 16 Command Track Area 

 

When the Command service is activate, any commands sent are listed in the Command 

Track Area in the Main Window.  The Command Track Area columns are described 

below.   

 

Command 

The Command column displays the name of the command sent. 

 

Uplink Time 

The Uplink Time column displays the time the command was sent. 

 

Command Response Columns 

Command Response columns will be displayed if the Destination supports command 

responses.  For a POIC Destination, command response columns are displayed.  For the 

International Space Station (ISS) command response types include:  ERR, CAR1, CAR2, 

FSV1, FSV2, and CRR.   
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If command responses are supported, the command response will be color coded to 

indicate success (green) or failure (red).  It is possible to retrieve additional information 

about a command response by double clicking on the item in the Command Track list.  

This will display a dialog similar to the one shown in Figure 17. 

 

 

Figure 17 Command Response Details 

 

For Destination Types that don’t support command responses, there are no additional 

columns that will be displayed.  Figure 18 shows the Command Track Area configured 

for a UFO destination type. 
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Figure 18 Command Track Area Configured for a UFO Destination 

 

Double clicking on a command track item in this configuration will yield the dialog 

shown in Figure 19 since there are no response details available. 

 

 

Figure 19 Response Details Message 

 

Command Track Dialog 

The Command Track dialog is shown in Figure 20.  The Command Track dialog displays 

the same information that is displayed in the Main Window Command Track area.  

Please reference section 6.4 for details. 
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Figure 20 Command Track Dialog 

 

Clear 

The Clear button will clear all command track information in all views (Command Track 

in the Main Window and the Command Track dialog). 

 

6.5 Command Communication Dialog 

The Command Communication dialog is shown in Figure 21.  This dialog is used to view 

the communication with the command destination.  Information is displayed in a 

text/hexadecimal format.   
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Figure 21 Command Communication Dialog 

 

6.6 Command Preferences Dialog 

The Command Preferences dialog is shown in Figure 22.  This dialog is used to configure 

command preferences.   The Set to Defaults button can be used to reset the properties in 

this dialog to application defaults. 
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Figure 22 Command Preferences Dialog 

 

Each field is described below. 

 

Command Confirmation Prompt 

If the Command Confirmation Prompt checkbox is checked, a dialog will be displayed 

asking for confirmation to proceed each time an Initiate or Send action is requested. 

 

TReK 3.x API Compatibility 

The TReK 3.x API Compatibility checkbox can be used to set a flag to allow TReK to 

behave the same as TReK 3.x with respect to the AddHeaderAndUplinkCommand() 

function.  In TReK 3.x this function required two extra bytes for the checksum.  TReK 

5.x no longer requires those bytes.  When the checkbox is checked, TReK will remove 

those two extra bytes to mimic the TReK 3.x behavior.  This will also change the TReK 

5.x behavior for the InsertDataAndUplinkCommand method of the CommandApi class.  

It should only be used if you are exclusively using the TReK 3.x compatible API. 

 

Maximum Number of Command Track Items to Display 

This field is used to enter the maximum number of command track items to display.  This 

must be an unsigned integer value.  Once the maximum is reached, older track items are 

deleted to make room for new track items.  The “Log TReK Command Interface 

Messages” capability, available on the Advanced Settings dialog, can be used to log all 

command track information.  To capture all command track information, this capability 

should be turned on prior to activating the command service. 

 

Maximum Number of Command Communication Messages to Display 

This field is used to enter the maximum number of command communication messages 

to display.  This must be an unsigned integer value.  Once the maximum is reached, older 

messages are deleted to make room for new track items.  The “Log TReK Command 

Interface Messages” capability, available on the Advanced Settings dialog, can be used to 
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log all command communication messages.  To capture all messages, this capability 

should be turned on prior to activating the command service. 

 

Pad Non-String Variable Length Command Fields 

If this checkbox is checked, variable length command fields that have a data type of 

“unspecified bytes” will be padded to word boundaries with the pad byte identified in the 

Pad Byte field if needed. 

 

Pad Byte 

This field is used to enter the pad byte to use when padding non-string variable length 

command fields.  This must be a one byte hexadecimal value.  This field will only accept 

hexadecimal entries. 

 

Terminate String Command Fields 

If this checkbox is checked, string command fields will be terminated with the terminator 

identified in the Terminator field if space is available. 

 

Terminator 

This field is used to enter the terminator to use when terminating string command fields.  

This must be a one byte hexadecimal value.  This field will only accept hexadecimal 

entries. 

 

 

6.7 Manage E-Mail and Text Settings Dialog 

The Manage E-Mail and Text Settings Dialog is shown in Figure 23.  This dialog 

provides the capability to manage global e-mail and text settings, application alert 

settings, e-mail and text dropboxes, and the capability to send an e-mail or text. 
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Figure 23 Manage E-Mail and Text Settings Dialog (Global Settings Account Tab) 

 

The TReK software’s e-mail and text capability is dependent on libcurl, an open source 

client-side URL transfer library developed by the cURL project. The libcurl library 

provides C API functions that configure the library to programmatically establish a 

secure connection with an email server using a Transport Layer Security (TLS) version 

1.3 socket prior to logging into an email account using an email account name and 

password. 

 

The TReK email and text capability has been successfully tested with the Google Gmail 

server.  It is recommended that users create a new Gmail account and use it to send 

emails and texts to designated recipients.  The TReK software does not support retrieving 

emails from the user's Gmail account.  When creating the Gmail account to send emails 

and texts you will need to configure your Gmail account to enable two-step verification 

and you need to generate a Gmail App Password for TReK.  Please reference Gmail Help 

for instructions.  The Gmail App Password is used in place of your e-mail account 

password on the Global Settings Account tab in the “Manage E-Mail and Text Settings” 

dialog.  TReK recommends only using the Gmail account to send emails and texts using 

the TReK software.  TReK does not recommend using the account to receive emails. 

 

The maximum size of a text message is approximately 900 characters.  However, if you 

send more than 900 characters your message may be broken up during transmission and 

then concatenated on the recipient’s phone.  The maximum length of a TReK email 

message is 65,000 characters or bytes.  The maximum length of an email with a file 

attachment is generally considered to be 10MB (email message size plus file attachment 

size).  Note, file attachments may become much larger than their original file sizes.  This 
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is due to the encoding employed by email servers when sending non text-based 

information. 

 

Global Settings 

Global Settings are e-mail and text settings used in all TReK applications.  They can be 

changed in any TReK application with a Manage E-Mail and Text Settings dialog.  When 

you change a setting on the Global Settings tab, it will be changed for all TReK 

applications.  Each Tab is described below. 

 

Allow Alerts 

The Allow Alerts Checkbox is a global setting to turn on and off all alerts in all TReK 

applications.  If you turn this checkbox off, no alerts will be generated in any 

applications. 

 

Export  

The Export button provides access to the Export dialog shown Figure 24.  This dialog 

provides the capability to save the settings on the Global Settings tab in a TReK email 

configuration file that can be used with the TReK E-Mail and Text API.  You also have 

the option to include the dropboxes defined on the E-Mail and Text Dropboxes tab. 

 

 

Figure 24 Manage E-Mail and Text Settings (Export Dialog) 

 

Account 

In order to use the Alerts capability, you must have a Gmail account.  The Gmail account 

must be configured with two-step verification enabled and you must have a Gmail App 

Password for TReK.  Please reference Gmail Help for instructions.  The Account tab is 

used to enter your Gmail account information.  The TReK software only stores account 

information locally.  The account password will be hidden by default and will always be 

encrypted when it is stored.  Please enter the Gmail App Password you generated for 

TReK in the E-Mail Account Password field (not your Gmail account password).  This 

password will only be decrypted when it is used communicate with the Gmail server to 

execute a requested function.  An example of account information is shown below. 

 

smtp_server_address:  smtp.gmail.com 

email_account_username: jane.doe@gmail.com 

email_account_password: Gmail App Password for TReK [Hidden unless show 

checkbox is checked] 
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email_address:  jane.doe@gmail.com 

email_name:   Jane Doe 

 

The Verify Certificate Authorities checkbox is used to turn on the certificate authority 

check.  If you turn on the certificate authority check, you must provide the complete path 

to a Certificate file. 

 

The Enable Curl Debug Messages checkbox is used to turn on additional debug messages 

generated by the curl software library. 

 

 

E-Mail List 

The E-Mail List tab is used to enter e-mail addresses that will be used to populate the e-

mail address list that is available when configuring alert functions or sending an e-mail.  

The E-Mail List tab is shown in Figure 25.  The Add button is used to add a row to enter 

e-mail address information.  The Delete button is used to delete a row. 

 

 

Figure 25 Manage E-Mail and Text Settings Dialog (Global Settings E-Mail List Tab) 

 

Cell List 

The Cell List tab is used to enter mobile cell phone numbers that will be used to populate 

the Cell list that is available when configuring alert functions or sending a text.  The Cell 

List tab is shown in Figure 26.  The Add button is used to add a row to enter cell number 

information.  The Delete button is used to delete a row.  Cell numbers can be entered 

with or without dashes.  The Set Carrier button is available when a Cell Carrier cell is 
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selected.  It is shown in Figure 27 and can be used to select a carrier address.  If the 

carrier address you need is not in the list, you can enter it directly into the cell. 

 

Note:  The cell carrier list is populated from a file in the TReK install (config/cell.txt).  If 

you wish to edit the file and make a custom list of carriers to be displayed in the dialog, 

copy the cell.txt file to the root directory of the TReK workspace and make your changes.  

If a cell.txt file exists in the root directory of the TReK workspace, it will be used instead 

of the one available in the install. 

 

 

Figure 26 Manage E-Mail and Text Settings Dialog (Global Settings Cell List Tab) 
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Figure 27 Manage E-Mail and Text Settings (Set Carrier Dialog) 

 

Group List 

When configuring an application alert or sending an e-mail or text, you will have the 

option to identify an e-mail address, a cell phone number, or a group as a recipient.  The 

Group List is shown in Figure 28.  You can define zero or more groups.  A group can 

contain e-mail addresses and cell numbers.  If you have a group with both e-mail 

addresses and cell numbers and you send an e-mail to that group, the e-mail generated 

will only be sent to the e-mail addresses in the group.  You can add, modify, and delete a 

group using the buttons on the right. 
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Figure 28 Manage E-Mail and Text Settings Dialog (Global Settings Group List Tab) 

 

The Add button will display the Add Group dialog shown in Figure 29.  At the top you 

can enter a name for the group.  On the left you will see all the e-mail addresses and cell 

numbers you entered on the Global Settings main E-Mail List and Cell List tabs.  You 

can add zero or more e-mail addresses and zero or more cell numbers to a group.  To add 

an e-mail or cell to the group, select the e-mail or cell number on the left and push the 

Add button to add it to the group.  You can use the Delete button to delete a recipient 

from the group. 

 

 

Figure 29 Manage E-Mail and Text Settings (Add Group Dialog) 
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Application Alerts 

The Application Alerts tab is shown in Figure 30.  It is used to configure application 

specific alerts.   

 

 

Figure 30 Manage E-Mail and Text Settings Dialog (Application Alerts Tab) 

 

 

 

Enable Application Alerts 

The Enable Application Alerts Checkbox is used to turn all alerts on or off in the current 

application.  If you uncheck Enable Application Alerts, no alerts will be generated in the 

Command application. 

 

Event List 

The Event area provides the capability to identify one or more alerts to send when a 

specific application event occurs.  You can add, modify, and delete alerts using the 

buttons on the right.  The Add button will display the Add Alert dialog shown in Figure 

31.   
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Figure 31 Manage E-Mail and Text Settings (Add Alert Dialog) 

 

Event 

The Event is what triggers the alert.  There may be one or more events in an application 

that can trigger an alert.  The Command application can generate an alert for the 

following types of events: 

 

Lost Connection 

This event is triggered if the command connection to the HOSC is lost. 

 

Type 

The type of alert to send.  Options are E-Mail, E-Mail and Text, or Text. 

 

Recipient 

The recipient identifies who should be notified when the event is triggered.  The 

Recipient list will be populated with applicable recipients based on Type.  If you select E-

Mail in the Type menu, the Recipient list will be populated with e-mails from the E-Mail 

List tab and groups that contain at least one e-mail address from the Group List tab.  If 

you select E-Mail and Text in the Type menu, the Recipient list will be populated with 

groups from the Group List tab that contain at least one e-mail address and one cell phone 

number.  If you select Text in the Type menu, the Recipient list will be populated with 

cell phone numbers from the Cell List tab and groups that contain at least one cell phone 

number from the Group List tab. 

 

Additional Text 

The alert will contain the name of the event that occurred and any text that is provided in 

the Additional Text field.  Additional Text is optional. 

 

 

E-Mail and Text Dropboxes 

The E-Mail and Text Dropboxes tab is shown in Figure 32.  This tab can be used to 

define E-Mail and Text Dropboxes.  It is important to remember that each E-Mail and 

Text Dropbox will correspond to a directory on the file system and must be unique.  

Using a directory for more than one dropbox will result in unexpected behavior.  When 
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you define a dropbox using the Manage E-Mail and Text Settings dialog, the dropbox 

information is automatically saved with that specific application’s settings. 

 

 

Figure 32 Manage E-Mail and Text Settings Dialog (E-Mail and Text Dropboxes Tab) 

 

Dropbox List 

The Dropbox List is used to define zero or more dropboxes.  For each dropbox you can 

define the Dropbox Type, the Dropbox Path, the Dropbox Success Path, a Recipient, and 

a State.  The buttons on the right can be used to add, modify, delete, or change the state 

of a dropbox.  The Add Dropbox dialog is shown in Figure 33. 

 

 

Figure 33 Manage E-Mail and Text Settings (Add Dropbox Dialog) 
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Dropbox Type 

There are three types of dropboxes: E-Mail, E-Mail File, and Text.  An E-Mail dropbox 

will e-mail the contents of a text file placed in the dropbox.  An E-Mail File dropbox will 

e-mail the file placed in the dropbox.  A Text dropbox will text the contents of a text file 

placed in the dropbox.  E-Mail and Text dropboxes only support text files.  Dropping 

other file types into these dropboxes will have unexpected results (e.g. send garbage).  

The E-Mail File dropbox supports many common file types including but not limited to 

text files, Portable Document Format (PDF) files, and Microsoft Office files.  It does not 

support executable files.  The E-Mail File dropbox will generate an error or fail to send 

file types that are not supported.  

 

Dropbox Path 

The Dropbox Path identifies the local directory to be used for the dropbox.  The Browse 

button can be used to select a directory.   

 

Dropbox Success Path 

The Dropbox Success Path is optional.  If the Dropbox Success Path is defined, the 

dropbox will move the original file placed in the dropbox to the success directory if and 

only if the corresponding e-mail or text is successfully delivered to the e-mail server.  If 

the success path is empty, the dropbox will delete the original file placed in the dropbox 

if and only if the corresponding e-mail or text is successfully delivered to the e-mail 

server.  If the dropbox fails to generate the e-mail or text, the file will be renamed with a 

time tagged ".droperror" extension and remain in the dropbox.  The dropbox will not 

attempt to generate an e-mail or text for a file with a ".droperror" extension in its 

filename.  

 

Recipient 

The Recipient identifies the designated recipient(s) for the e-mail or text.  The Recipient 

list will be populated with applicable recipients based on the Dropbox Type.  For 

example, if you select E-Mail or E-Mail File in the Type menu, the Recipient list will be 

populated with e-mails from the E-Mail List Tab and groups with at least one e-mail 

address from the Group List Tab.  If you select Text in the Type menu, the Recipient list 

will be populated with cell phone numbers from the Cell List Tab and groups with at least 

one cell number from the Group List Tab. 

 

State 

The state controls whether the dropbox is activated.  It can be set to Off or On.  If the 

state is set to Off, the dropbox will not be activated.  If the state is set to On, the dropbox 

will be activated when you push the OK button.  If the state is set to On when you exit 

the application, it will automatically be activated the next time you run the application.  If 

you do not want the dropbox to be activated on application initialization, set the state to 

Off before exiting the application. 

 

 

Send E-Mail 
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The Send E-Mail tab is shown in Figure 34.  This tab can be used to send an e-mail if 

valid information has been entered on the Global Settings tab.  Once the To, Subject, 

optional File (Browse can be used to browse the local disk for a file), and Message 

information has been entered, press the Send button to send the e-mail.  This will initiate 

a request to send the e-mail.  Look at the main window message area for information 

about whether the e-mail request was successful or encountered any errors. 

 

 

Figure 34 Manage E-Mail and Text Settings Dialog (Send E-Mail Tab) 

 

 

Send Text 

The Send Text tab is shown in Figure 35.  This tab can be used to send a text if valid 

information has been entered on the Global Settings tab.  Once the To and Message 

information has been entered, press the Send button to send the text.  This will initiate a 

request to send the text.  Look at the main window message area for information about 

whether the text request was successful or encountered any errors. 
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Figure 35 Manage E-Mail and Text Settings Dialog (Send Text Tab) 

 

 

6.8 Advanced Settings Dialog 

The Advanced Settings dialog provides access to configure several advanced settings.  

The Advanced Settings dialog is shown in Figure 36. 

 

 

Figure 36 Advanced Settings Dialog 

 

Communication Timeout 

You can set the timeout value used in communication with the Huntsville Operations 

Support Center.   It is unlikely there would ever be a need to modify this setting.  The 

timeout value can only be modified when the Command service is inactive.   



TREK-USER-0014 

 42 

 

Log TReK Command Interface Messages 

The TReK Command application provides the capability to log messages that are 

exchanged between the TReK Command application and the Destination to a file.  This 

capability has been provided for troubleshooting purposes.  Hopefully this is a feature 

you will never need to use.  If you check the Log TReK Command Interface Messages 

checkbox, the messages that are exchanged between the TReK Command application and 

the Destination will be written to the log file specified.  Message Logging will start when 

the Command service is activated and stop if you uncheck the box or the Command 

service is deactivated.  Once a log file exists, any new messages will be appended to the 

existing log file.  Log files are appended with the time the file was created as shown in 

the example below.  Log files older than 7 days are automatically deleted. 

 

Example Log File:  trek_command_interface_message_log_2021-03-14-18-26-49.txt 

   

Log Directory  

The Log Directory field should contain the absolute path to the directory where the log 

file should be written.  

   

Log Filename 

The Log Filename field should contain the name to use for the log file. 

 

 

6.9 POIC Connection Acknowledgement Dialog 

The POIC Connection Acknowledgement Dialog is shown in Figure 37.  This dialog 

displays information about the POIC Connection Acknowledgement.  The Decrease Font 

and Increase Font buttons decrease and increase the font.  The Fill Background checkbox 

will display color information by filling the background of the Value column. 
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Figure 37 POIC Connection Acknowledgement 

 

6.10 POIC Command System Configuration Dialog 

The POIC Command System Configuration Dialog is shown in Figure 38.  This dialog 

displays information about the POIC Command System Configuration.  The Decrease 

Font and Increase Font buttons decrease and increase the font.  The Fill Background 

checkbox will display color information by filling the background of the Value column. 
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Figure 38 POIC Command System Configuration 

 

6.11 POIC Command System Status Dialog 

The POIC Command System Status Dialog is shown in Figure 39.  This dialog displays 

information about the POIC Command System Status.  The Decrease Font and Increase 

Font buttons decrease and increase the font.  The Fill Background checkbox will display 

color information by filling the background of the Value column. 
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Figure 39 POIC Command System Status 

 

6.12 Application Messages 

Various types of application messages are generated including information, progress, 

warning, error, and debug messages.  Application messages are stored in memory and 

written to a temporary log file.  The temporary log file is created on application 

initialization and exists as long as the application is running.  It is deleted when you exit 

the application.  The log file is located in the temporary directory provided by the 

operating system.  Only a subset of messages are stored in memory while all messages 

are written to the temporary log file.  The maximum number of application messages 

stored in memory is controlled by the message storage setting in the Configure Messages 

dialog.  Once the maximum is reached, older messages are deleted to make room for new 

messages.  Setting the maximum value to a large number can impact application 

performance since it will increase the amount of memory used by the application.  Setting 

this number too low can cause you to miss important messages.  The application default 

was selected to protect against both of these scenarios.  Messages stored in memory are 

displayed in the Main Window Message Area and the Messages dialog.  The Messages 

dialog is shown in Figure 40.  The Main Window message area only displays Info, 

Warning, and Error messages.  The Messages dialog displays messages based on the 

display preferences defined in the Configure Messages dialog.  By default, the Messages 

dialog will display information, progress, warning, and error messages.  Columns in the 
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Messages dialog can be sorted by clicking on the column header.  The Messages dialog is 

available from the Options menu.   

 

 

Figure 40 Messages Dialog 

 

Configure 

The Configure button provides access to the Configure Messages dialog shown in Figure 

41.  This dialog provides access to preferences associated with messages.  Display 

preferences can be set to filter the types of messages (category) displayed in the 

Messages dialog.  Export Preferences control how the time tag is added to the filename 

that is created when messages are exported.  See the Export section for details.  Message 

storage defines the maximum number of messages that will be stored in memory while 

the application is running.  Once the maximum is reached, older messages are deleted to 

make room for new messages.  The Set to Defaults button can be used to reset these 

properties to application defaults.   

 

 

 

Figure 41 Configure Messages Dialog 

 

 

Clear 

The Clear button provides access to the Clear Messages dialog shown in Figure 42.  This 

dialog provides two ways to clear application messages stored in memory.  You can clear 



TREK-USER-0014 

 47 

all the messages or clear selected messages.  Once you clear messages, the messages are 

permanently deleted in all views (Main Window Message Area and the Messages dialog).   

 

 

Figure 42 Clear Messages Dialog 

 

Export 

The Export button provides the capability to save all the application messages currently 

in memory to a file.  When you push the Export button you will be prompted for a 

directory and filename.  Export will save all messages in memory, not just the messages 

currently displayed in the Messages dialog (i.e. the Display Preferences are not applied).  

The name you provide for the file will be modified with a time tag that is added to the 

filename.  The time tag indicates the time the file was closed.  The default is to append 

the time tag to the filename.  For example: 

 

Filename Input:   messages.txt 

Filename Output: messages_2017-05-07_13~03~28.txt 

 

If you would like to prepend the time tag to the filename you can set this preference in 

the Configure Messages dialog.  This would result in the following: 

 

Filename Input:   messages.txt 

Filename Output: 2017-05-07_13~03~28_messages.txt 

 

 

Delog 

The Delog button provides the capability to save all application messages generated since 

the application was started.  Delog will retrieve the messages from the temporary log file.  

When you push the Delog button you will be prompted for a directory and filename.  A 

timetag is not applied to the filename. 

 

Filename Input:   messages.txt 

Filename Output: messages.txt 

 

6.13 Application Configuration File 

The Command application saves the following information when you save a 

configuration:   
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➢ Configuration information in the Configure Dialog. 

 

6.14 Application Settings 

The Command application saves some settings as application settings each time you exit 

the application.  The next time you run the application, the application will initialize with 

the previous application settings.  Only one set of settings are saved.  If you run multiple 

instances of the application, the settings in the instance that is exited last will be saved.  

The following application settings are saved: 

 

➢ Application Window Size 

➢ Command Preferences 

➢ Configure Messages Selections 

➢ E-Mail and Text Settings 

➢ Advanced Settings 

 

6.15 Application Command Line Arguments 

The Command application accepts the following command line arguments: 

 

➢ trek_command.exe <filename> 

 

filename to open a configuration file (full path to file) 

 

A value must be wrapped in double quotes if it contains spaces. 

 

Example: 

 

➢ trek_command.exe “D:/command config.xml” 

 

➢ trek_command.exe D:/command_config.xml 

 

 

If the configuration is valid, the application will automatically activate the command 

service. 

 

7 FAQ and Troubleshooting 

This section addresses Frequently Asked Questions and provides tips for troubleshooting 

common gotchas. 

 

No FAQs Yet. 

 


